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The Eudora Pro 4.2 User Manual is on your CD in electronic form. If you would like a printed copy, 
you may print that, or order a printed copy from www.eudora.com or call 1-800-2-EUDORA.

This Quick Start Guide shows how to install and configure the Eudora Pro® Email software, hereafter known
as Eudora. It also provides keystroke shortcuts and basic email procedures such as sending and receiving
messages. For the Macintosh version, turn this booklet over.

You can find more information about Eudora in the "Eudora Pro 4.2 User Manual" included on the installation
CD. The manual is in Portable Document Format (PDF). To read the manual, use the Adobe® Acrobat Reader,
a software utility also included on the CD.

After you install Eudora, you can access the manual via the Start menu. Select Eudora Pro, and a list of items
pertaining to Eudora appear. Choose User Manual. Acrobat Reader automatically opens the manual. If you
prefer, you can print the PDF manual. From the File menu in Acrobat Reader, choose Print. 

The manual’s topics are linked. When you see a page number associated to a topic in the table of contents,
index, or in a reference, click the page number and that topic appears.

If you need help while using Eudora, go to the Help menu and choose a topic. Context-sensitive help is
available by pressing F1 or clicking            and selecting the option or field you need information on.

F I N D I N G  I N F O R M A T I O N
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Before you successfully install Eudora, you need to know the following basic information about your email account.
Either your Internet Service Provider (ISP) or your email administrator can provide you with this information.

■ Return email address 

This is the email address that has been assigned to you by your ISP or your organization. It is the address other
people use to send you email. An example return address is: jim@myfirm.com

Record your Return address here

■ Login name

This is the name you use to log into your mail account. Your ISP or organization provides it. It is generally, but
not necessarily, the name that appears before the at-sign (@) in your return email address. In the example above,
“jim” is the login name.

Record your login name here

■ Mail account password

This password allows you to access your mail account. Your ISP or organization provides the password but you
can change it. Keep this password private.

■ Incoming mail server name 

Your incoming mail account resides on a computer at your ISP or within your organization. Your incoming
mail server name is the full name of that computer, with no login name or at-sign (@) required, for example,
pop3mail.myfirm.com or imap4mail.myfirm.com.

Record your incoming mail server name here

■ POP3 or IMAP4

This is the protocol that your incoming mail server uses. Your incoming mail server must use one of these two
Internet protocols for storing and forwarding your mail. Ask your ISP or email administrator which one it uses.

Note. If you are setting up an IMAP account, it may require an IMAP Location Prefix. Obtain this information
from your ISP or email administrator. Otherwise, leave the following box blank.

If applicable, record your IMAP Location Prefix here.

■ Outgoing mail server name

This server, an SMTP server, receives and processes all of your outgoing mail. It also resides on a computer at
your ISP or within your organization. The server name is often the same computer as your incoming mail
account. Your SMTP server name is the full name of that computer, with no login name or at-sign (@)
required, for example, smtp.myfirm.com. If your ISP or your email administrator has not given this server
name to you, you can leave the box blank.

Record your SMTP server name here.

G E T T I N G  S T A R T E D  
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■ Your registration number 

This number is provided in the Eudora product box. If you purchased this product electronically in software
archive format, your registration number is provided in an accompanying email message. 

The registration number entitles you to receive technical support from QUALCOMM. Use this number when
registering your product electronically. If you are a member of an organization using Eudora, your email
administrator handles the registration process. 

Record your Registration Number here.

Once you have the above information, you are ready to install, configure, and register your copy of Eudora.

If you are installing over a previous version of Eudora Pro or Eudora Light, all of your messages, mailboxes,
folders, filters, and options are maintained.

To install Eudora, perform the following steps.

1 Exit any applications you are running including toolbars, memory management programs, window savers,
and virus protection programs.

2 If you are installing from a CD, insert the CD into your CD-ROM drive. The Windows 95/98/NT autoplay
feature will cause the Eudora Pro installer to launch (if the installer does not launch, from the Start menu,
choose Run and enter the CD-ROM drive letter and then setup.exe, for example, D:\setup.exe). If you are
installing from a software archive, double-click on it to start the Setup program. 

4

Installation begins, and you can see the InstallShield extract the Eudora files. 

The Eudora Welcome window is displayed.

3 Read the Eudora Welcome window, then click Next. 

4 Read the Software License Agreement and if you agree to the terms, click Yes.

5 In the Choose component dialog box, enter your User Code, then click Next.

Your User Code number is printed on the technical support information sheet found inside the Eudora
product box, or if you are part of a multi-user site, it should be provided to you by your email administrator.
If you purchased Eudora by electronic distribution, the User Code is in the message you received when you
purchased the product. User codes and registration numbers are different numbers.

6 If you want to install all components (if included), click Next. Deselect the components you do not want
to install.

7 Specify a directory in which to install Eudora, then click Next.

If you are installing Eudora over your current version of Eudora Pro or Eudora Light, select your current
Eudora directory to retain your settings. If you are installing Eudora for the first time, you can select any
directory you want.

I N S T A L L I N G   E U D O R A
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Eudora is installed in the destination directory.

Note.  In certain versions of Eudora, you may elect to install Apple QuickTime™ for Windows. If so, the
QuickTime Software License Agreement appears. Click Agree and then follow the instructions in the
QuickTime installation dialogs. If you have a newer version of QuickTime installed, it will not be replaced.

8 You are prompted to create a shortcut to open Eudora from your desktop. If you want to place the Eudora
icon on your desktop, click Yes. 

9 When the installation is complete, you are prompted to view the Eudora README file. Click Finish to
complete the installation and view the README. The README gives you important information concerning
this version of Eudora.

You can uninstall Eudora by using the tools provided with your Windows 95, Windows 98, or Windows NT
4.0 (or later) operating system. Open the Control Panel, double-click on Add/Remove Programs, select
Eudora Pro, and click Remove.

After you have successfully installed Eudora, you must configure your email account using the information
that you collected in the Getting Started section of this Quick Start Guide.

To open and configure Eudora, do the following:

1 From the Start menu, choose Programs, then select Eudora Pro and choose Eudora Pro again or click the
Eudora Pro icon on your desktop. The first time you launch Eudora, the New Account Wizard appears
(unless you installed Eudora 4.2 over an older copy of Eudora, in which case, the settings from the older
copy are imported automatically into Eudora 4.2). 

6

2 To get started, click Next. After the Welcome window appears, the New Account Wizard Account Settings
window appears.

Select the method of setting up your account:

■ Create a brand new email account — Select this method to set up a new account if you are not familiar
with Eudora or other email programs. You are prompted to enter one item of information per dialog box. 

■ Import settings from an existing email account —  Select this method if you want to import your settings,
mail, and address book from Microsoft ® Outlook Express™ 4.0, Outlook™ 98, or Netscape Messenger™ 4.2
into Eudora. This process may take time depending on the amount of mail, the complexity of your settings,
and the size of your address book.

If you need more information on migrating settings from one e-mail program to Eudora, see "Importing
Settings to Create a New Account" in the online user manual. Note that this process may take some time
depending on the amount of mail, the complexity of your settings, and the size of your address book.

U N I N S T A L L I N G   E U D O R A

O P E N I N G  A N D  C O N F I G U R I N G  E U D O R A
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■ Use an ACAP server to get your settings — Select this method to instruct Eudora to attempt to get your
settings from an ACAP server. To get your settings from an ACAP server, make sure you are connected to
the Internet. Your email administrator or ISP can provide you information as to whether an ACAP based
setup is available to you.

If you choose the ACAP option and click Next, the Auto Configure window appears. Click Next again to
instruct Eudora to try to get your account settings from the ACAP server. If the attempt fails, click Back and
try one of the other options.

■ Skip directly to advanced account setup — Select this method if you are familiar with Eudora or other
email programs. An Account Settings window appears with two tabbed panels. You enter all of your
Eudora information on these panels.

If in the Account Settings window you choose to create a brand new email account and click Next, the New
Account Wizard begins walking you through the fields for which you need to enter setup information.

You will need to supply the following items in the windows of the New Account Wizard (click Next after
filling out each window):

■ Your Name — Enter your name as you would like it to appear in the From: field of all of your outgoing
messages from this email account, indicating to your recipients who the mail is from.

■ Email Address — Enter the email address that has been assigned to you by your ISP or your email administrator.
This is the address that other people will use to send you email. Return addresses are generally of the form
loginname@domainname, and rmonte@myfirm.com is an example.

■ Login Name — Enter the name that you will use to log in to this email account. This name is provided by
your ISP or your email administrator, and it usually consists of the text that appears before the at sign (@)
in your return email address. In the example rmontgomery@myfirm.com, the login name is rmontgomery.

■ Incoming Email Server — All of your incoming email messages are delivered to your incoming email
account, which resides on a computer that runs your incoming email server. Once your messages arrive at
your mail account, Eudora retrieves them to your computer. Your incoming email server must use one of
the two Internet-mail communications protocols: POP or IMAP. If you are not sure which protocol it uses,
select POP; you can always change this later. In the edit box, type the full name of the computer that runs
your incoming email server, for example: server.myfirm.com

98

this later. In the edit box, type the full name of the computer that runs your incoming email server, for
example: worldmail.myfirm.com 

If you chose IMAP in the previous setup panel, an IMAP Mailbox Location Prefix may be required to indicate
the location of your personal mailboxes on the IMAP server. If so, enter the name of that location prefix as
given to you by your ISP or email administrator. If the information is not required, leave the field blank. Now
click Next. When you click Finish in the final window, your new IMAP email account is set up.

If you chose POP in the previous setup window, click Finish in the final window, and your new POP email
account is set up.

Once you have completed setting up your account via the New Account Wizard, you are now ready to
receive messages. However, you may need to take an additional step to send messages.

■ Outgoing Email Server — All of your outgoing email messages are sent through a specific server, usually
an SMTP server. However, your outgoing server may be the same as your incoming server. If you’re not
sure what your outgoing server’s name is, use the incoming server’s name. 

If the computer that runs your POP or IMAP server also runs an SMTP server, then no additional setup
action is required. If your SMTP server runs on a different computer from the one running your POP or
IMAP server, then consult your ISP or email administrator to help you set up the SMTP server. If you ever
wish to change the settings of your email account, you can do so from the Options windows (under the
Tools menu). 

Also, you can change these settings in the Account Settings dialog, which is accessed from the Personalities
window. This window lets you create alternate email accounts and edit the settings in those accounts. 

Once you have configured Eudora, you are ready to begin sending and receiving messages. For a quick
introduction to Eudora basic functions, refer to the procedures provided in this guide and in the online help.
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You can manually check for mail, or set up Eudora to automatically check for mail. 
To check for mail manually, do the following:

1 From the File menu, choose Check Mail. 

2 If Eudora asks for your password, type it in the Password dialog box and click OK. Usually server
passwords are case-sensitive. 

3 If there is no mail for you, a "no mail" alert appears; click OK. 

4 If you have new mail, Eudora transfers the messages one by one and then displays a new mail alert; click OK. 

5 New messages are delivered to your In mailbox. This mailbox opens automatically, and your new message
summaries are added to the end of the mailbox list. Double-click a message summary to open it. Or, click
once on the message summary to select it, then view the message in the preview panel below the list.

To set up automatic mail checking, do the following:

1 From the Tools menu, choose Options. Then, select Checking Mail. 

2 In the Check for mail every __ minutes field, type the number of minutes between automatic mail checks
(15 is the recommended interval). 

3 To save your changes and  close the Options window, click OK.

Eudora automatically checks for mail at the interval you have requested.

To create and send a message, do the following:

1 From the Message menu, choose New Message. 

2 Type an email address (or nickname you created) in the To: field. 

3 Press [tab] to move the blinking cursor to the Subject: field. 

4 Type the subject of your message (optional).

5 Press [tab] and type in the Cc: field email address (optional). 

6 Press [tab] and type in the Bcc: field email address (optional).

7 Press [tab] twice and type in the body of the message. 

8 After completing the message, click Send (or Queue).

Tip: You can type multiple addresses in the To:, Cc:, and Bcc: fields, as long as you separate them with commas. 

Also, you can save a message without sending it by selecting Save from the File menu. Your message is saved
in the Out mailbox. It can be reopened and edited at any time prior to sending it.

1110

C R E A T I N G  A N D  S E N D I N G  A  M E S S A G E C H E C K I N G  F O R  A N D  R E C E I V I N G  M A I L

S E T T I N G  U P  A U T O M A T I C  M A I L  C H E C K I N G
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To reply to a message, do the following:

1 Select or open the message you want to reply to. 

2 From the Message menu, choose Reply to display a new composition window. Eudora completes the To:,
From:, and Subject: fields based on the original message. 

3 Remove those parts of the original text that you don’t want to include in your reply and type in your own text. 

4 Once your response is completed, click Send (or Queue). 

You forward a message when you want someone else who was not on the original recipient list to see it. To
forward a message, do the following:

1 Select or open the message you want to forward. 

2 From the Message menu, choose Forward to display a new composition window. Eudora completes the
Subject: field based on the original message and transfers the header and body of the original message to
the new message body. 

3 Type the addresses of the people you want to forward the message to in the To: field. 

4 The existing text may be edited, and more text may be added to the message.  

5 Once the editing is completed, click Send (or Queue).

12

Eudora’s Redirect command lets you send a message that was sent to you to someone else, while allowing
the recipient of the redirected message to reply directly to the original sender. 

To redirect a message, do the following:

1 Select or open the message you want to redirect. 

2 From the Message menu, choose Redirect to display a new composition window. Eudora completes the
From: field with the address of the originator and the words "by way of" and your name and/or email
address. The Subject: field and message body are also completed based on the original message.

3 Type the email address(es) of the person(s) to whom you wish to redirect the message in the To: field.

4 The existing text may be edited, and more text may be added to the message.

5 Once the editing is complete, click Send (or Queue).

The shortcuts for Eudora functions are as follows:

Press these keys: Results

Ctrl + 0 Open Out mailbox

Ctrl + 1 Open In mailbox 

Ctrl + ’ Paste as quotation 

Ctrl + , Finish address book entry (nickname) 

R E P L Y I N G  T O  A  M E S S A G E

F O R W A R D I N G  A  M E S S A G E

R E D I R E C T I N G A  M E S S A G E

S H O R T C U T S
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Ctrl + A Select all 

Ctrl + B Make text bold

Ctrl + C Copy 

Ctrl + D Delete 

Ctrl + E Send immediately or Queue for delivery 

Ctrl + F Open Find Messages window 

Ctrl + Shift + F Open Find text dialog box 

Ctrl + H Attach file 

Ctrl + I Make text italic 

Ctrl + J Filter messages 

Ctrl + K Make address book entry (nickname) 

Ctrl + L Open Address Book 

Ctrl + M Check mail 

Ctrl + N New message 

Ctrl + O Open file 

Ctrl + P Print 

Ctrl + Q Exit Eudora 

14

Ctrl + R Reply 

Ctrl + S Save current window 

Ctrl + T Send queued messages 

Ctrl + U Make text underlined 

Ctrl + V Paste 

Ctrl + W Close one mailbox at a time (message or window) 

Ctrl + Shift + W Close all open mailboxes (messages or windows) 

Ctrl + X Cut 

Ctrl + Y Directory Services 

Ctrl + Z Undo 

Ctrl + Tab Go through all open mailboxes

MAY 1999     80-48360-1
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